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Micro Focus Enterprise Developer 2.3
Update 2 for Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

• Micro Focus Enterprise Developer Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is suitable for anyone
who wants to become familiar with the Eclipse or Visual Studio means of editing and compiling
mainframe applications under Windows.

• Micro Focus Enterprise Developer Connect

Enterprise Developer Connect is for customers looking to use modern and productive Eclipse-based
tooling to develop mainframe applications directly on the mainframe. Close integration to mainframe
configuration management systems and the ability to easily customize the Eclipse-based IDE to include
mainframe-based tools and processes means developers can take full advantage of modern
development tools without having to learn new development processes.

• Micro Focus Enterprise Developer

Enterprise Developer is for customers looking to develop and modernize mainframe applications in a
productive and modern Windows-based development environment, targeted for deployment onto an
alternate server platform. Developers have the choice of either the Visual Studio or the Eclipse-based
IDE and development and test tools are provided for all target environments currently supported by
Micro Focus.

• Micro Focus Enterprise Developer for z Systems

Enterprise Developer for z Systems gives customers the choice to develop directly on the mainframe or
under Windows. Mainframe applications can be developed, maintained and modernized regardless of
where they will be deployed, either back onto the mainframe or onto an alternative server environment.
Support is provided for both the Visual Studio and Eclipse-based IDEs and for all the development and
test tools for every target environment currently supported by Micro Focus - including z/Linux, AIX and
x86 environments.

Enterprise Developer for z Systems combines all the capabilities of Enterprise Developer Connect and
Enterprise Developer.
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Full mainframe integration and the Application Workflow Manager are only available in the Eclipse-
based IDE.

Note:

• The Application Workflow Manager is available within all Enterprise Developer variants and
provides all the capabilities and tools to develop and maintain Application Workflow models. These
models allow you to integrate tools and processes directly into Enterprise Developer. You can use
the Application Workflow Manager with the following products:

• Enterprise Developer - the Enterprise Developer setup file automatically installs the Application
Workflow Manager.

• IBM Rational Developer for System z (RDz) - see Installing Application Workflow Manager into
Rational Developer for System z (RDz) in the installation instructions. This requires that
Enterprise Developer Connect is installed and licensed.

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise
Developer in the product Help.
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What's New
This release provides enhancements in the following areas:

• Integration with Eclipse
• Application Workflow Manager (AWM)
• CICS Web services (Early Adopter Program)
• COBOL language enhancements
• Compiler directives
• Database access - DSNREXX
• Editor writing assistance
• File handling
• IMS support
• Interface Mapping Toolkit
• Library routines
• PL/I support
• Tutorials

Integration with the Eclipse IDE

Back to Top

Enhancements are available in the following areas:

• The following settings have been added to the BMS page in the project's and file properties - Redefine
Input, SDF Map Size, and Hyphenate Field Suffix.

• Using the search facility, Search > Micro Focus, you can now limit the search to the copybooks used
by the current program rather than all copybooks in the project or the entire workspace.

• The editor provides a new context menu command, Extract COBOL code to copybook, that enables
you to move a selected segment of the code to a new copybook file in your project. The segment of
code moved to a copybook is replaced with a COPY statement in the original program.

• Support for Eclipse 4.5 - after installing Enterprise Developer, you can add it as a plugin into a separate
instance of Eclipse 4.5. See your product's Installation notes.

Application Workflow Manager (AWM)

Back to Top

This release provides enhancements in the following areas:

AWM model editor:

• It is now possible to use drag and drop not only for objects of the same type but in all cases where this
is relevant. For example, it is now possible to drag tool descriptors onto an action descriptor which will
create an "Action Descriptor has Tool" relationship. Dragging a File_Descriptor_has_Property
relationship onto an element list structure will create an Element_List_Structure_has_Column
relationship.

• It is now possible to group any major modelling objects such as action descriptors, properties and tool
descriptors in the AWM model editor.

AWM modelling:

• The Eclipse function package includes a new tool, "Build Project", and the MVS function package
includes a new tool, "Refresh DataSet".
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• "Edit MVS File" now provides a parameter to the editor ID.
• The AWM meta model has the following enhancements:

• New model objects for configuring the decoration of labels displayed in the Team Developer Tree
view.

• Visible conditions for enabled conditions. You can use the visible conditions to specify whether an
action should be shown on an element's context menu.

• A new application-specific attribute, INITIAL_PARSE, enables you to specify whether the background
parse process of the editor should start when a file is opened in the editor.

• The Eclipse function package includes a new category of linked properties that support the Eclipse
team properties.

• The Eclipse linked element types now support the "Run As", "Debug As" and "Profile As" context
menu actions.

AWM z/OS extensions:

• The Micro Focus z/Server connection now provides an Owner filter.
• The Micro Focus z/Server connections support case sensitive input of passwords.
• The RDz function package provides a new tool which opens MVS resources depending on the RSED

connection defined in the Micro Focus z/Server connection. This now enables you to download
copybooks in RDz environments using the Micro Focus z/Server connection.

Micro Focus model extensions:

Support is available in the Micro Focus model extensions (the Enterprise Development Projects model and
the SCM models for Endevor, ChangeMan, SCLM and SVN) for:

• The Eclipse team linked properties
• Grouping modelling objects in the editor
• Visible conditions
• The "Run As", "Debug As" and "Profile As" commands

CICS Web services (Early Adopter Program)

Back to Top

Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.

The CICS Web Services feature is EAP for development and testing usage. It should not be used for
production deployment in this product release

This release provides an initial support for CICS Web services (CWS) using an SOAP-based provider and
requester modes and using HTTP or MQ as the transport mechanism. CICS Web services support the
Coded Character Set Identifier (CCSID) and configuring the CCSID is a prerequisite for CWS in all
environments.

Restriction: Security and Web Service Atomic Transactions (WSAT) are not currently supported.

COBOL language enhancements

Back to Top

Numeric, edited and external floating point items can now specify USAGE NATIONAL when the
NATIONAL"2" Compiler directive is in effect. Signed numeric items must be specified with the SIGN IS
SEPARATE clause.

Compiler directives

Back to Top
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The following Compiler directives are new in this release:

• COMMAND-LINE-LINKAGE - enables you to call a program and pass the command line to the main
program as a parameter to be accessed via the Linkage Section. This offers equivalent functionality to
the command_line_linkage tunable, which has now been deprecated.

• EBC-COL-SEQ - controls the behavior of an EBCDIC collating sequence, specified in a
NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long-standing fixed
(platform-independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

• NATIONAL - enables you to specify numeric, edited and external floating point items as USAGE
NATIONAL.

Database access - DSNREXX

Back to Top

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.

DSNREXX support is available for use with Enterprise Server using DB2 LUW and SQL Server. See
DSNREXX Support for more information.

Editor writing assistance

Back to Top

This release provides the following enhancements:

• Colorization of conditional compilation regions - by default, inactive code is now colored the same as
Compiler directive elements. Inactive code is defined as code within conditional blocks that do not
evaluate with the applied Compiler settings.

• $REGION statement - support is provided for the $REGION Compiler-control statement. You can use
$REGION - $END-REGION to surround blocks of code that you want to fold or expand in the editor.

• AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version. This
feature is enabled by default and can be configured from a new preference page in Window >
Preferences > Micro Focus > COBOL > Editor > AutoCorrect.

File handling

Back to Top

MFJSORT ICETOOL now supports the USING parameter in the SELECT operator.

IMS support

Back to Top

This release supports the PROMPT keyword in MFS source files.

Interface Mapping Toolkit

Back to Top

This release supports JSON schemas for the generation of REST Web service clients in the Eclipse IDE.

Library routines

Back to Top
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The following library routine contains new functionality:

• CBL_GET_PROGRAM_INFO - a new function (function 10) has been added for native COBOL which
returns the path and program name, or the program name only of a particular program.

PL/I support

Back to Top

This release provides the following enhancements:

• New built-in functions - support has been added for the ONCONDID() and SAMEKEY() built-in
functions.

• Support for strings declared with the VARYINGZ attribute - the Open PL/I compiler and run-time system
now support the use of VARYINGZ strings as variables, parameters, and targets for built-in functions.
This provides an improved compatibility with IBM's mainframe compiler, and the ability to more easily
interact with other languages such as ANSI C.

• Improved PL/I macro preprocessor compatibility - the Open PL/I compiler now supports all macro
preprocessor built-in functions used by IBM's PL/I Macro Preprocessor.

• Improved compatibility with IBM's Structure Alignment rules - the -zalign option of the Open PL/I
compiler now maps structure elements of the BIT data type that do not consume a full byte to the same
boundaries as IBM's PL/I compiler. This helps make the migration of mainframe data files to a
distributed platform easier and improves the program execution compatibility.

• Improved floating point support - the Open PL/I Code Generator now utilizes the newer Intel floating
point operands for improved speed. In addition, the Code Generator now provides improved
compatibility with passing parameters between C and COBOL.

• PL/I editor improvements:

• A new context menu command in the editor, Extract PL/I code to an include file, which enables
you to move a selection of code in the editor into a new include file. The extracted code is replaced
with an %INCLUDE statement which references the include file.

Tutorials

Back to Top

The product help includes the following new tutorials:

• Tutorial: SQL - Deploying an Enterprise JavaBean Containing JVM COBOL to a JBoss Application
Server - that walks you through the process of deploying an EJB that contains JVM COBOL code.

• Tutorial: DSNREXX, that walks you through the process of executing DB2 LUW queries using
DSNREXX.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• AppMaster Builder
• Enterprise Server
• Compiler
• Eclipse IDE
• MF Directory Server
• Monitoring and Management
• JCL Support
• PL/I Support
• Run-Time System

AppMaster Builder

Back to the list

• To correct a problem with generating programs when no APRPROG member is present, a new Output
Generation preference has been added that, when enabled, creates a temporary APSPROG member at
generation time if none is found. In addition, a new customizable APRPROG template is available to
enable customization of the temporary APSPROG member.

2849347 (1103014)

Compiler

Back to the list

• Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)
• There is no longer a problem opening an RM/COBOL indexed file when the program has a RECORD

CONTAINS n CHARACTERS clause and there are record descriptions with lengths less than n. This
situation previously caused a 39 error on the OPEN (other than OPEN OUTPUT) because there was a
mismatch in the minimum record length.

Eclipse IDE

Back to the list

• This update modifies any existing connections defined in an Eclipse workspace. If the connections had
any non-default values, those values could revert to their original default setting. After installing this
release, before you use any remote connections for the first time, you need to check the settings and
amend them as necessary.

2852872 (1103699)

Enterprise Server

Back to the list
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• Previously, it was possible to install groups that should not have been installed. If a group name, as
defined in the Startup List, did not exist in the list of Groups then the next Group in the alphabetical
order would be loaded instead. Now, if a Group is not defined in the list of Groups, a warning that the
Group could not be loaded is issued.

2869848 (619107)
• On UNIX, if the "File Path" setting was not specified in the configuration of an Enterprise Server, the

environment variable TXFILEP was defaulting to $COBDIR/etc/cas. This has been changed and
TXFILEP is not populated when the "File Path" is not specified.

(618668)

MF Directory Server

Back to the list

• The "-n" option for the mfds command now supports hostnames as the network addresses in addition to
IPv4 addresses.

2816871 (1099564)

Monitoring and Management

Back to the list

• Messages that are written to the console log by applications that perform "display upon console" now
contain a standard message ID (CASMG0001I).

2854207 (1103659)

JCL Support

Back to the list

• A printer exit can now evaluate the spool copybook field lk-dest-source-is to find the source of the value
in the spool DEST-NODE and DEST-USERID fields, to determine if it is from a SYSOUT 'DEST=' value
or from a /*ROUTE PRINT value.

2852302 (1103304)

PL/I Support

Back to the list

• A problem with PUT STRING when compiled with the -bigendian option in effect has been fixed. Note
that when upgrading to ED 2.3 U2 you must recompile any program using PUT SPRING.

2857374 (1104039)

• Previously, if using the -incafter option of the macro preprocessor to infuse a %INCLUDE with macro
logic, you were required to schedule a second macro pass to preprocess the contents of the
%INCLUDE. This is no longer necessary and the macro logic will be preprocessed on the first macro
pass as if it was part of the original source.

• Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)
• Previously, if SIGPIPE was triggered when a PL/I program was in the callstack, then PL/I error handling

got control and processed the ERROR. This no longer occurs. Users who rely upon catching SIGPIPE
can re-enable it by adding a call to cobpostsighandler() to their code to turn it back on.

2859980 (1104399)
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Run-Time System

Back to the list

• The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

2838118 (1101539)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Application Workflow Manager

• In an Application Workflow Manager modelled action, you retrieve a file from the remote zOS system
directly into a COBOL project, you must set the text file encoding of the COBOL project to UTF-8 in the
project properties in order for the Compiler to correctly process the source code. To set the encoding, in
the project properties of the COBOL project and on the Micro Focus > Project Settings > COBOL,
specify the source-encoding(utf8) Compiler directive in the Additional directives field.

• In some situations, when you start Enterprise Developer for the first time from a new workspace, you
might receive the following error message: "'System Loader' has encountered a problem. TSCOR0149
Failed to load AWM systems." You can ignore this message as this has no impact on the product and on
your applications.

Debugging

• When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.

• Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:

1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
  <DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>

3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.

4. Start Eclipse from the same command or shell prompt.
• Remote debugging does not work for programs running on AIX or HP machines, if you are trying to

debug using Enterprise Developer installed on a Linux machine.

Database Access

• If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual COBOL or HCO for
DB2 LUW in Enterprise Developer and the DB2 software is not installed on the client machine where
you are using the Eclipse IDE, you receive background parsing errors in your application. To resolve the
issue, you can do either one of the following:

• Disable background parsing Window > Preferences > Micro Focus > COBOL > Editor and
disabling the checkbox for Background parsing.
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• Install the IBM DB2 client-side software on the machine on which you are running Eclipse. Go to the
IBM Support Home and locate the page entitled "IBM Download Fix Packs for IBM Data Server
Client Packages" .

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

• In Enterprise Developer 2.3, some job scheduling tools from third-party vendors might stop
communicating with Enterprise Server. This might have an impact on our external partners who
integrate with Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur
with job schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment
with the path set. Click here for more information about the issue and how to work around it.

IDE

• If you are upgrading your license from Enterprise Developer for Eclipse Personal Edition (v2.2 or earlier)
to Enterprise Developer, or from Enterprise Developer Connect (v2.2.1 or later) to Enterprise
Developer, any existing projects compiled to either .exe or .dll files using the old license must be
updated in order to recreate the .cobolBuild file. You can do this done by adding or removing files
from the project or by deleting the .cobolBuild file. Updating the project in this way ensures Eclipse
will fully build the executable files.

Mainframe Access

After a QSAM text export, for some files you might incorrectly receive a message that a record's length
exceeds the data set LRECL. Micro Focus recommends that you check the exported data set for
completeness.

Micro Focus Rumba

• On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

PL/I Support

• The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.

• On SUSE, the PL/I CodeWatch debugger does not display output with MicroFocus ViewNowX. To
resolve this issue, you need to install a HotFix of ViewNowX - contact Micro Focus SupportLine for more
details.

• Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
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to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Viewing the Product Help

• A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with searching and indexing the
help in the Eclipse help viewer if you are running Eclipse on a machine that has this version of JRE
installed.

z/Server

• IBM's PTF UA75804 causes ISPF dialogs in a user server to stop working. If you have this PTF
installed, contact Micro Focus SupportLine to obtain a fix for this issue.

-2814867 (1098663)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Application Workflow Modeller
• AppMaster Builder
• Assembler Support
• Character Animator
• CICS Support
• Code Analysis
• Codeset Support
• Common Communications Interface
• Compiler
• Communications Server
• Data Tools
• Debugging
• Dialog System
• Documentation
• Editor Writing Assistance
• Enterprise Server
• File Handling
• H2cpy
• HCO for Microsoft SQL Server
• IDE
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Licensing
• Mainframe Access
• Mainframe Batch Scheduler Integration
• Micro Focus Directory Server
• MVS REXX Emulation
• OpenESQL
• PL/I Support
• Setup
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: OpenESQL
• SQL Option for DB2
• XML Syntax Support
• z/Server

Application Workflow Modeller

Back to the list

• Modeled AWM actions will not be displayed in the "Team Developer Table View" once the
"Show_In_Tree_View" attribute is set to false.
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2865194 (1105117)
• Fixed MVS function package tools "Edit MVS File" and "Browse MVS File" that were not working for

sequential files under RDz V9.5.1.

2863835 (1104931)
• Fixed an issue with creating element lists while tools of an action descriptor were disabled due to

unfulfilled enabled conditions.

2863345 (1104882)
• "AWM RDz Integration" now supports RDz V9.5.1.

2855824 (1103952)
• Passwords containing UTF-8 double-byte characters are now handled correctly by z/Server.

2811914 (1101605)

AppMaster Builder

Back to the list

• During a screen generation it is now possible to optionally omit <screen>-SCR-GENED-DATE from the
generated SCRSYMB member. To disable the generation of SCR-GENED-DATE, you need to modify
the file tailoring member SSMSCGEN (ISPSLIB/SSMSCGEN) and change the setting for $GENDATE
from YES to NO. This file tailoring modification is required for backwards compatibility and covers
scenarios where you might want this symbol to be included in the generated screen file.

2866713 (1105469)
• A problem using the Tab key to move the cursor from one control to another in the AppMaster Builder

Editor caused code generation failure. This has been fixed by changing the behavior as follows: o 'Tab'
character has been replaced with space/blank character(s). o When pressing the 'Tab' key in a Keyword
area, the cursor moves to the Painter's statement area. o When pressing 'Tab' key in statement area,
the 'Tab' character is replaced by spaces, where the number of spaces is determined by the tab size in
set in preferences, which is usually 4.

2865685 (1105222)
• The APRPROG member is now renamed correctly.

2865681 (1105215)
• The generation process now performs a search for empty files or files that do not exist and displays an

appropriate message in the console. If a file is empty or does not exist, it is now denoted with a special
icon in the tree view.

2849461 (1103620)
• When performing a BUILD command on a Database View where SQL was not loaded, the job was

failing after erroneously invoking SQLIMP.exe.

• The logic in Online Express has been changed so it is no longer possible for Online Express to shut
down if the OX program editor is still active for editing of local code. This also helps prevent locking a
user out of Online Express.

2858886 (1104243)

• The AppMaster builder screen painter, Attributes Dialog, now enables you to specify values in the
Length and Column fields. Modifying the Row in this dialog is still prohibited.

2864711 (1105123)
• The AMB Screen painter was not allowing to drag fields which are less than 79 characters in length into

column 80.

2861645 (1104640)
• The AMB Screen generation was incorrectly using the default mapset-name in the generated symbols

when a mapset name had been supplied. Also, the value specified for the CICS parameter "Starting
line" was not saved.
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2854521 (1103658)

• A problem with the 'Unnumber' editor command deleting codes has been fixed.

2867293 (1105487)
• A problem with the COBOL project name appearing incorrect on the Application Preferences page has

been fixed.

2865309 (1105141)
• As a part of Workgrouping support, a new option for COPYLIB folder location(s) has been added. When

you have a COBOL Project directory specified in your AppMaster Builder Preferences, you can include
the $COBOLPROJECT$ variable as a location for the COPYLIB library type. $COBOLPROJECT$
resolves to the defined COBOL Project directory. You can further qualify $COBOLPROJECT$ by adding
one or more subdirectories separated by a forward slash (/). For example, $COBOLPROJECT$/copylib.

2864587 (1105322)
• A mainframe stub with an incorrect localPath attribute was not showing in the browser. This has been

fixed.

2863601 (1104898)
• A problem with the 'Change Project' menu not appearing has been fixed.

2862013 (1104784)
• A problem with COBOL project properties showing when displaying AppMaster Builder project

properties has been fixed.

2860184 (1104421)
• A problem with the creation of a new APRAPPL member when editing an item of the program has been

fixed.

2857813 (1105793)
• AppMaster Builder 'Copy+Add' Object option has been added in this release.

2855723 (1103804)
• PSBSRC members containing a PSBGEN statement with a PSBNAME keyword on a continued line of

code were being processed incorrectly. AppMaster Builder now reads continued lines to obtain the
PSBNAME keyword. In addition, the Load process now generates a warning instead of stopping when it
does not find a referenced DBD.

2854996 (1103719)
• A problem with the Job Queue not refreshing properly when receiving focus has been fixed. In addition,

the Job Queue now deletes jobs older than the specified date.

2854795 (1103728)
• To fix a problem with removing line numbers in the AMB Program Editor, new 'Renumber/Unnumber'

functionality has been added in this release via popup menus in the Editor and Renumber/Unnumber
icons in the Editor toolbar.

2853709 (1103554)
• A problem with the Project drop-down list not updating properly has been fixed so that the most recently

used project is listed at the top.

2853678 (1103679)
• A problem that caused the "Cannot change projects" message to remain after the jobs have completed

has been fixed.

2835023 (1103429)

Assembler Support

Back to the list
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• An issue where GENCB macro was causing SOC1 ABENDS at execution time has been fixed.

2864941 (1105224)

• STOW macros now accept invocations which omit the third argument. For example: STOW
(1),PDSNAME CLOSE MEMBER W/O REPLACE

2868167 (1105603)
• BPAM (Basic Partitioned Access Method) emulation has been fixed to allow an open output of PDSs

with no members.

2868167 (1105604)
• Assembler LAY instructions were incorrectly Soc5 abending when a negative displacement was

specified. This has been fixed so instructions of the form LAY 14,-262144(,14) work correctly.

2862443 (1104723)

• Assembler Add Packed (AP) instruction was not detecting numeric overflow as per IBM's z/OS
specifications for 32-bit mathematical operations. The overflow detection logic in the Assembler Run-
Time system has now been changed to properly detect all condition codes associated with 32-bit add
operations.

2861800 (1104652)

Character Animator

Back to the list

• The source file is now found when it is located in the same directory as the .idy file.

2852782 (1103425)

CICS Support

Back to the list

• Previously, HSF records for CICS transactions were incorrectly given a type of JCL under SSTM.

2854986 (1103786)

• A trap could sometimes occur if an EZASOKET call was made before MFCS was ready to process the
call.

2861431 (1104615)
• CICS SEND FROM statements now support a new option, _NOCONVERT. When this is set, the

associated data stream will not be converted between ASCII and EBCDIC.

2858809 (1104228)
• During the auto-install of a terminal that would result in a duplicate terminal, the duplicate terminal

would hang and each attempt to reconnect would create a new invalid terminal entry. Also, attempts of
an IMS terminal that uses a predefined NETNAME to reconnect would fail.

2857211 (1104013)
• When trying to write to the local trace table, a flag was not initialized properly which resulted in a crash

in casgreqt.

2854635 (1103673)
• An issue causing some memory leak has been fixed.

2848625 (1102926)

• When an ambiguous handle does not need to be qualified within an exec cics statement (i.e. a
paragraph exists in the same section as the exec cics statement, and a duplicate paragraph name
exists in another section), "COBEC1402S HANDLE label not unique" will no longer be returned.

2871628 (1106156)
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• The NOCONVERT and CCSID options are now supported in the GET/PUT CONTAINER APIs.

2830735 (1100803)
• Non-unique locations within EXEC CICS statements are now flagged as Not Unique when compiled if

they need to be qualified.

• An issue where CICS INQUIRE REQID returned EIBRESP=NORMAL even when no REQID was
present in the system has been fixed.

2870593 (1106043)
• A CWI group in the startup list would cause intermittent 252 Run-Time System errors in casgate,

especially under load.

2865028 (1105237)
• Timeouts specified by ECI clients are now honored.

2864330 (1104999)
• Previously, data returned on an EXEC CICS READQ TD command could be truncated. This could only

occur for regions running without TRANCLASS specified.

2863822 (1104922)
• The value of IOAREALEN in T-TYPE definitions is now honored during the auto-installation of the

Universal Client terminal.

2863437 (1105060)
• An issue causing a memory leak when using CICS POST has been fixed.

2862452 (1104719)
• An issue causing file locks when using CICS SPOOLOPEN has been fixed.

2858609 (1104717)
• An issue with CWS using MQ transport where the reply was sent to the dead letter queue instead of to

the reply queue has been fixed.

2858022 (1104129)
• SET TERMINAL NEXTTRANSID is now being honored.

2851169 (1103193)
• An INQUIRE DSNAME now returns the dsname when ES_INQFILE_RETURN=DSN even if the datafile

has not yet been opened since the region started.

2850740 (1103167)
• If a region was active when a daylight savings or other timezone change was made, the new time would

not be reflected in the CICS ASKTIME API. The PERFORM RESETTIME command now behaves in the
same way as under CICS on the mainframe allowing a user-written program to update the system to
use the new time.

2842910 (1102203)
• The BMS field attributes are now correctly applied for fields that are defined within a group.

2839597 (1101990)
• Enterprise Server now supports the CICS API SET TASK Purge, Forcepurge and Kill commands.

2810092 (1098212)
• The following new trace flags are now available in the System Initialization Table (SIT): srv - traces SEP

hosted task control functions; pcp (program control program) - traces program management functions.
• When MFDS uses SSL ports and the user navigates to ESMAC from MFDS, the HOME link now points

to the correct SSL port.

2863039 (1104794)

• A problem with the CICS API FORMATTIME incorrectly truncating seconds has been corrected. The
milliseconds value is now truncated if the milliseconds value is not requested.
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2868459 (1105680)
• A problem with user names and passwords importing into the resource definition file as upper case has

been fixed.

2868202 (1105606)
• It is now possible to run the casrdtex command on resource definition files defined with read-only

access.

2852401 (1103335)

Code Analysis

Back to the list

• The GO TO statements targeting non-exit paragraphs query no longer returns points inside EXEC
statements.

• The performance has been improved.
• The criterion for dead statements within a program has been modified to exclude child elements of

statements.
• Level 78 constant names used in picture definitions are now replaced with the actual values.
• An issue with de-referencing NULL pointers during program generation has been fixed.
• An issue with de-referencing a NULL pointer has been fixed.

Codeset Support

Back to the list

• A number of DBCS translation tables for CODESET have been added to the deployment product to fix
the 'COBRT255 CODESET cannot open double byte conversion table' error.

2858171 (1104157)
• The following changes have been made to CODESET tables: • The Japanese Katakana Extended

codeset (country code 81) now corresponds to EBCDIC code page 290 when converting between
ASCII and EBCDIC, which means lower case letters (which start at x61, and not x81) can now be
converted. • Unused entries for the following codesets have been filled in order to allow round tripping
(ASCII>EBCDIC>ASCII conversions) of SBCS values: • Japanese Latin Extended, country code 939,
which corresponds to EBCDIC code page 1027. • Korean, country code 82, which corresponds to
EBCDIC code page 833. • Simplified Chinese, country code 86, which corresponds to EBCDIC code
page 836. • Traditional Chinese, country code 886, which corresponds to EBCDIC code page 37.

Common Communications Interface

Back to the list

• The formatting of the context help pages for the Enterprise Server Administration HTML GUI has been
improved.

Communications Server

Back to the list

• MFCS now accepts security configurations which do not include optional data such as the "Authorized
ID" for security managers.

2865680 (1105868)
• Enterprise Server now provides some new options for EZ Sockets support for Mainframe Subsystem

Enterprise Server applications. You can use these options to enable your applications to share sockets
without using GIVESOCKET/TAKESOCKET. See the product Help (available from
documentation.microfocus.com) for a description of the "share descriptors" option.

2863608 (1104885)
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• TN3270 conversations no longer hang, looping in the MFCS process, if the client sends a malformed
TN3270E header. A message will now be written to the MFCS log and the input record will be
discarded.

Compiler

Back to the list

• When a program uses SQL, the debugger could highlight the wrong line when entering that program.
This has been fixed.

2869190 (1105765)
• On 32-bit Intel platforms you could receive an error "001-F Internal error 38" when generating for debug.

2856865 (1104040)
• A COBRT114 error produced at generate time has been fixed.

2853877 (1103611)
• An error in the "ACCEPT binary-floating-point-item" syntax, which occurred on Intel x86 platforms in 32-

bit generated code, has been fixed.
• On UNIX or Linux, Intel x86, 32-bit platforms, callable shared objects no longer state a spurious line

number when reporting RTS 163 run time errors.

• If more than one report shared the same FD, for example: REPORTS ARE REPORT-1 REPORT-2. then
under HOSTRW, the record length was wrong. This has been corrected.

2865849 (1105553)
• Programs using B-AND, B-OR, or B-XOR now compile with the ARITHMETIC"ENTCOBOL" Compiler

directive in effect.

2864991 (1105087)
• A DISPLAY statement containing a very large number of operands now compiles as expected.

2864361 (1105017)
• An inline method invoke with a variable-length group item now produces correct object code.

2864131 (1105018)
• Report Writer now generates the correct record length. Previously, if the BLOCK CONTAINS clause

came after the RECORD CONTAINS clause in the File Descriptor, the BLOCK would corrupt the value
from the RECORD clause, causing the record to have the wrong length when written to the file.

2863045 (1105008)
• The use of 'AS' as a data-name for programs using an SQL ECM now works as expected.

2863002 (1104821)
• If an INVOKE statement specifies more parameters than the method actually has, an appropriate error

message is produced. Previously, an 'internal error' error message was produced.

2860899 (1104519)
• An INITIALIZE statement performed on a subscripted table containing fields that are object references

or procedure pointers now executes as expected.

2860416 (1104588)
• Messages produced by the FLAGSTD directive now have the correct line and column info reported in

the IDE.

2859026 (1104318)
• A COBOL program compiled with the PROFILE Compiler directive now shows information on the

number of times the program has been called, as well as loaded.

2858944 (1104278)
• When REPLACE is active, a literal containing '''' now compiles as expected.
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2858804 (1104264)
• A compilation where a user pre-processor is specified below CP in the pre-processor stack, and this

pre-processor passes COPY statements through unopened, now works as expected.

2858013 (1105427)
• Compilation of a STRING statement, with an operand that reference modifies the result returned by a

user function, now works as expected.

2857266 (1104189)
• A new directive, EBC-COL-SEQ, now controls the behavior of an EBCDIC collating sequence, specified

in a NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long standing
fixed (platform independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

2856776 (1104074)
• SCREEN SECTIONs with very large amounts of fields, which worked in Net Express, now work in

Visual COBOL.

2854533 (1103648)
• Copybook dependency information is now shown correctly in Eclipse for programs compiled with a

preprocessor such as CP.

2854371 (1103662)
• Compiler warning message "COBCH972 Linkage item (or subordinate item) is referenced but has no

addressability" is no longer produced inappropriately.

2854113 (1103542)
• The use of the HOSTRW and CURRENT-DATE directives no longer causes an excessive number of

lines in a report produced from the Report Writer.

2853789 (1105472)
• Subscripts specified via intrinsic function LENGTH-AN no longer receive spurious boundary violation

error messages.

2851928 (1103254)
• Preprocessor created error messages containing SJIS characters are now displayed correctly, as

expected.

2646229 (1089272)
• A USE FOR DEBUGGING statement that references a table item and is triggered by a condition where

the table item is referenced but not evaluated (due to short-circuit evaluation) now executes as
expected.

2433731 (1073167)

• There is a new option, CP, in EXECPERIOD. It controls the processing of periods that follow EXEC
statements. In most scenarios, the default option, EXECPERIOD(SMART), enables you to compile by
applying a flexible behavior based on the program's context.

2867788 (1105608)

• A CALL statement inside a method could sometimes lead to bad code generation, leading to verification
errors on program load. This is now fixed.

2856883 (1103973)

Data Tools

Back to the list

• DFCONV now correctly supports a command line length of 1024 characters, as documented.

2868190 (1105640)
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• The classic Data File Tools utility now shows the correct field sizes for PL/I array elements.

2858068 (1104147)
• The DFCONV utility now converts correctly between IEEE and 370 floating points.

2857502 (1104054)

Debugging

Back to the list

• In Eclipse, program breakpoints in a program with DECLARATIVES now stop correctly when the
program is entered.

2868653 (1105740)
• When repeating the debugging of remote 64-bit applications, Eclipse would occasionally hang.

2846587 (1102616)
• When the COBANIMSRV environment variable was used under Windows for cross-session debugging

under Eclipse, the working-storage data items might have displayed 'RT114 error' instead. These items
should now display correctly.

• When debugging a program or core file, stack unwind through a signal trampoline could fail on AIX 7.1.

Dialog System

Back to the list

• The Dialog System configuration information can now be updated using the painter.

Documentation

Back to the list

• The documentation of the format of CCI.INI has been corrected.

2867660 (1105532)
• The product help now clarifies that navigation bar in Visual Studio displays the lists of the objects and

procedures used in the current program as well as the Procedure Division, any sections, paragraphs,
and group level data definitions and enables you to position the cursor on any of them.

2858290 (1104219)
• The topic "Making the Most Out of The COBOL Editor" in the product help for Visual Studio now

provides a link to the information about limitations with single file support.

2858263 (1104217)
• Information on setting the mfdepinst security credentials in the .mfdeploy file in the deployment parent

directory has been added to the documentation.

2854625 (1103607)
• The product help now includes information about the ExcilRespException and InvalidDataException

classes and corresponding serialized form information.

2851195 (1103171)
• The 'This Page' help link in Enterprise Server on UNIX now opens the Help.

2818256 (1099110)
• Changing the project's connection type can result in the project losing the connection to its version

control system. You can re-establish the connection with your version control system in the Share
Project dialog.

2792882 (1101965)
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• Step five in the installing on UNIX was missing the period that goes before "/opt". It now reads:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

2855600 (1103829)

• The product help has been updated to remove the requirement to install the gcc libraries. These
libraries are not required to install and configure the product and then for the basic functionality. gcc is
only required if you need to use C and COBOL together and gcc will be installed together with the
required development tools.

2863618 (1104878)
• User exits MFDASIMP and MFDASEXP are now documented.

2858575 (1104507)
• Updated the information on the action of the MFJESPWR user exit program contained in the

documentation.

2856725 (1103944)
• The DATAFIELD built-in function has been removed from the documentation.

2852986 (1103391)
• Details have been added to the topics "To enable Windows Event Logging" and "To enable Performance

Counters" to state that the user must be able to write to the appropriate registry, and have appropriate
privileges, to complete these tasks.

2840002 (617369)
• ECI programs that use mfccl.jar raise an error exception, EXCIException, if exciResp1 and exciResp2

are not both equal to zero. To ensure your ECI program captures all errors, you must catch this
exception in your code. Please add the following code snippet, which enables your program to compile
and execute properly: try { … } catch(ExciException e) { String rcMsg = e.getRcMsg(); } If an error
occurs, rcMsg captures the appropriate error message.

2830787 (1100664)
• The documentation for the “MF Directory Server Security” page has been clarified, to show that the

Security Facility Configuration parameters are available on this screen only when MFDS is configured to
use an ESF (i.e. setup to use a Security Manager other than "MFDS Internal Security"), otherwise no
ESF security configuration options (including the caching options) will be seen on this MFDS Security
tab screen. These parameters are: Allow unknown resources Allow unknown users Cache limit Cache
TTL Create audit events Verify against all Security Managers

• The product Help now includes some additional details on creating advanced filters for using regular
expressions with the Compare and Synchronization Monitor.

2645110 (1089268)

Editor Writing Assistance

Back to the list

• IntelliSense (Visual Studio) and Content Assist (Eclipse) would sometimes not offer reserved word
types where they were valid.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) offered unqualified managed members where
they could not be used without qualification.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) sometimes offered invalid pointer items.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) incorrectly offerred level 88 itens or require

them to be qualified.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer items in the PERFORM USING

statement.
• An issue where members with reserved word names were not colorized correctly has been fixed.

IntelliSense (Visual Studio) and Content Assist (Eclipse) suggestions are now offered in member
headers for members with names that are reserved words.
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• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not show options after items which were
subscripted or reference modified.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not correctly offer typedefs in LENGTH OF
phrases.

• Items from external programs were incorrectly offered in IntelliSense (Visual Studio) and Content Assist
(Eclipse).

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer variables with the same name as
classes, methods or properties in the same file.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer suggestions after variables with
the same name as classes, methods or properties in the same file.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) omitted options after the SET SIZE [OF]
statement.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer items within indexers on natively
typed arrays.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer or recognise PIC 1 items within
conditional expressions.

• IntelliSense (Visual Studio) showed the wrong members after a cast to SUPER.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) sometimes did not list any members after

names of unqualified types.
• The Content Assist (Eclipse) and IntelliSense (Visual Studio) lists would not include any options if there

where unknown parameter types in the code.
• Some IntelliSense (Visual Studio) and Content Assist (Eclipse) proposals for items from external

programs did not have any descriptions.
• If there were multiple items with the same name declared in external programsm they were not offered

correctly by IntelliSense.
• IntelliSense now supports constructing instances of the current or parent type using either NEW SELF

or NEW SUPER.
• IntelliSense in Visual Studio would sometimes show the wrong members for unqualified type names

within partial classes.
• Content Assist (Eclipse) and IntelliSense (Visual Studio) now offer to qualify file record items by their FD

items.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) would sometimes list the wrong members after

an unqualified type name.

Enterprise Server

Back to the list

• The CASGLM.LCK and ESCLRMLs.cfg files were not generated if the system catalog was in a spacey
path.

• The security when displaying any of the Enterprise Server configuration pages in the Enterprise Server
Administration HTML GUI has been increased.

2846702 (1102642)
• The "Renew" command available from the left hand side navigation pane in the Enterprise Server

Administration HTML GUI did not work when SSL was enabled.

• A potential memory corruption when a SEP executing an EXEC CICS DELAY is killed has been fixed.
This situation only occurred when TRANCLASS was enabled.

2865931 (1105228)
• An initial 3270 terminal connection could hang if there was an attempt to send an error message to the

terminal not yet connected and an XA error occurred at the same time.

2865927 (1105226)
• IN-only messages are now supported for CICS Web Services.
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2864329 (1104991)
• An issue causing an RTS 114 error in mfjclsub when a CICS program executed a 'display' call in an

SSTM-enabled region has been fixed.

2858651 (1104770)
• It is now possible to programmatically change the name of a Web service displayed in the HSF records

by calling the following entry point: call 'ES_trace_application_data' using by reference ws-trace-block .
Where ws-trace-block is defined as follows: 01 ws-trace-block. 03 ws-trace-version pic x comp-x. 03 ws-
trace-data. 05 ws-trace-type pic x comp-x. 05 ws-trace-text pic x(255). - ws-trace-version and ws-trace-
type must have a value of 1. - ws-trace-text is restricted to 255 bytes in length, must be terminated by
low-values (x'00) and must not have any spaces embedded in it.

2856234 (1103860)
• When using cassout from the API and not cancelling it between calls, it was possible to overwrite the file

output from a previous invocation if the '-d' option (output to file) was not specified. The product now
initializes the required environment variables on each invocation to ensure this problem does not occur.

2852058 (1103778)
• Trying to access ESMAC in a secure region no longer results in the application crashing.

2851933 (1103724)
• On a CICS stateful request, after a run-time system failure, a transient SEP could loop, produce an RTS

114 error or an abend CDCD on shutdown during SDP2. This was caused by the ATP not being at the
expected level when running SDP2.

2851618 (1103389)
• The casutl command line utility supports a new option, /n. When used with /n, the utility starts a new

console.log and saves the contents of the current console.log to a new file,
console.nnn_switch_date_time (where nnn is a number).

2851178 (1103265)
• Visual COBOL and COBOL Server with SOA now include castran with the CANCEL support.

2849934 (1103037)
• Credentials are now masked out in the formatted dump.

2848888 (1102908)

• A default password for an external Security Manager connection is no longer used when you specify a
user id but not a password. This is to help avoid locking out the user id. Also, if no password has been
specified, the Enterprise Server Administration HTML GUI no longer displays a dummy value in the
password field on the Security Manager configuration page.

2864790 (1105187)
• Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.

2863222 (1104948)
• Restricting access to the Enterprise Server External Security Facility's Admin API for the MLDAP ESM

Module now works correctly when you use resource definitions in the optional AdminAPI class.

2830660 (1100636)
• With some types of tracing enabled, the MLDAP ESM Module for Enterprise Server security would

sometimes report that a group ACE matched the user's logon group when in fact it did not match. The
trace message now correctly indicates whether the ACE matched or not.

• When using Enterprise Server security with LDAP, on some platforms, a resource access rule with an
empty access control list (ACL) could cause an RTS 114 or other program crash. This has now been
fixed.

File Handling

Back to the list
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• An internal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.

2868664 (1105707)
• When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler

was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.

2864802 (1106106)
• VB files are now created with the correct lrecl, taking into account the extra space for a print character

when creating the file header.

2856899 (1104023)
• FS_CHECK_FILE_EXIST is now being processed correctly when called with an environment variable

that contains a Fileshare server-name. Previously, the request was not being sent to the server.

2851717 (1103253)
• Memory is now correctly being deallocated at end of IMS rollback recovery processing; previously, it

was not.

2840046 (1101795)
• When running non-transactional file handling, a record-locked status will also return the process-id of

the locking process when run on UNIX and using FCD3. This means C$LOCKINFO can also return this
information for Micro Focus files. This behavior does not apply to Fileshare.

2832733 (1101061)
• The rollback recovery process is now working as expected.

2802180 (1097066)

• For corrupted files, where a corrupted offset occurs beyond the end of the file, you now receive a
validation message instead of a Run-Time System error 114.

2860981 (1104576)

• When MFJSORT fails to open SYSOUT, it now gives an error message to the console, and then
abends.

2861239 (1104614)
• The MFJSORT E15 user exit is now giving the correct record length.

2858360 (1104276)
• A COBOL SORT called from JCL no longer causes a COBRT200 error message in managed code.

2857600 (1104073)
• SORT now treats leading spaces in ZD fields as zero, which emulates mainframe behavior.

2855141 (1103700)
• The conversion of PD to ZD is now giving correct SORT results for negative numbers.

2854443 (1103597)

H2cpy

Back to the list

• H2cpy now successfully parses cURL header files.

2858155 (1104162)

HCO for Microsoft SQL Server

Back to the list
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• The OpenESQL pre-compiler generated code has been modified to perform swap logic for COMP fields
if an SQLCODE of -305 or -811 is also returned, as data can be returned with either of those
SQLCODEs.

2871163 (1106063)
• An issue with OpenESQL handling cursor names that start with "CURSOR" has been fixed.

2866507 (1105337)
• An issue where HCOSS was not locating the correct stored procedure for a bound statement in multi-

step JCL jobs has been fixed.

2861657 (1104733)
• When using DIALECT=MAINFRAME, if a program references a DECLARE GLOBAL TEMPORARY

TABLE before the declaration, the precompiler now produces a warning and not an error message.

2853667 (1103453)

IDE

Back to the list

• Copybook dependencies are now shown correctly within Eclipse for 64-bit compilations.

2866406 (1105576)
• You can now customize task tags for the COBOL, JCL, and PL/I editors.

2865386 (1105306)
• A password in no longer required to establish an SSH connection in the Remote System view.

2863953 (1105480)
• Additional options are now correctly saved in the .cobolBuild and .cobolProj files.

2863027 (1104789)
• A PL/I macro invocation used as a statement parameter is no longer reported as an error.

2862571 (1104763)
• PL/I background parse no longer reports an error when a macro replacement string is a DCL statement

that ends with a semicolon.

2862568 (1104767)
• There are new preferences for the JCL editor under Window > Preferences > Micro Focus > JCL >

Editor - "Remove trailing whitespace", "Remove trailing whitespace after column 80 only", and "Remove
all trailing whitespace".

2858636 (1104207)
• Code coverage report generation now works where a project depends upon a copylib project.

2858045 (1104184)
• The MFA connection sign-on dialog could be displayed at startup, it is now displayed when the

connection is being established.

2857986 (1104150)
• A PL/I macro invocation is no longer reported as an error when it does not contain parenthesis.

2856935 (1103989)
• Hyperlink detectors defined in the Eclipse preferences for "Textual Editors" were not enabled for the PL/I

and COBOL editors.

2856932 (1103984)
• The performance of the "Updating Micro Focus model" job, user interface responsiveness and memory

consumption have been improved when folders containing large numbers of files are added to an
Eclipse project.

2856154 (1105184)
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• This release includes a new preference "Continue comments on to new line" under Preferences > Micro
Focus > COBOL > Editor > Typing and Preferences > Micro Focus > JCL > Editor > Typing. You can use
this to control whether comments are automatically inserted on a new line when pressing Enter in a
comment.

2855770 (1103781)
• It is now possible to load templates in columns 1-7 in COBOL programs using content assist.

2855703 (1103770)
• Updating the Micro Focus Model could result in high CPU and Disk IO. This has now been fixed.

2854512 (1103605)
• The auth.pl process no longer hangs when the user ID is blank or null.

2851049 (1103233)
• The generated .cobolBuild ant scripts now contains target names using simple filenames instead of full

file system paths for the FileCompile.filename targets.

2847988 (1102977)
• A problem with the core Eclipse code could cause a full project rebuild to occur when not required. This

has now been fixed.

2816310 (1104735)
• Hyperlinking in the PL/I editor can now be disabled.

IMS Support

Back to the list

• When a GE status (record not found) was returned when accessing a secondary index directly as a
stand-alone DB, the database position was lost. This has been corrected.

2859678 (1104360)
• When using a PROCOPT=GO PCB to access a secondary index DB, a record locked status (9/068)

error message could occur when other active applications were updating adjacent records in the index.

2856236 (1103858)
• Secondary Index sparse exit routines were allowed to run in parallel in the multi-threaded IMS DB

Control process. Exit routines are now serialized by default to prevent any possible unintentional
storage corruption by exit routines which are not thread-safe. If all sparse exit routines are thread-safe,
you need to use the configuration variable ES_IMS_SERIAL_SPARSE_EXIT=0 to allow exit routines to
be multi-threaded.

2856235 (1103857)
• A qualified GU call to a PROCSEQ PCB with a key value greater than the last record of the SX DB

resulted in an unnecessary forward search across the entire SX DB. This has been fixed.

2855116 (1103841)
• On a heavily loaded system running a combination of read-only batch and online shared database

applications (MPP, BMP, or CICS), an invalid file status of 42, 48, or 49 sometimes resulted on a
secondary database index. This has been fixed.

2850171 (1103561)
• When editing an IMS database in the DB editor, a severe DLI call failure resulted in an editor crash

rather than setting the appropriate DLI status code. This has been corrected.

2849835 (1104252)
• A DLI status code (NE) was returned incorrectly to DLET call depending on secondary index definitions

and data population. This has been corrected.

2847064 (1103584)
• When a CHARSET(EBCDIC) program issued an EXEC DLI REPL call that omitted segments that were

included in the previous GET call, and then followed this with a path GET call, an invalid "AC" status
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code resulted. This has been corrected. The correction does not require a recompile of the
CHARSET(EBCDIC) program. This issue does not apply to CHARSET(ASCII) programs.

2843343 (1102714)

• The cursor position set by the application program on output is now working as expected. Previously,
the output cursor position was the positioned defined in the MFS source.

2868851 (1105753)
• An issue in the DBCS support incorrectly sets the model 7 terminals to a screen width of 80 characters,

this resulted in invalid overlapping field errors. Model 7 screen width is now set to the correct value of
132 characters.

2863035 (1104790)
• The output of IMS printed lines were one fewer than the number defined. This has now been fixed.

2859815 (1104349)
• For LU3 printing, the print buffer will no longer contain any trailing spaces. LU3 printing has output

buffer size limitations. Trailing spaces could result in the buffer exceeding the limitation.

2857377 (1104041)
• NULL characters defined in the MID are now correctly converted to the EBCDIC equivalent. This

addresses the problem where some code pages (for example, code page 932) like an ASCII null (x'1A')
does not convert to the expected EBCDIC null (x'3F').

2857213 (1104014)
• User should no longer abend when generating a large MFS source. The literal pool sizes have been

increased to take into account an earlier increase to the number of MFLDs.

2856514 (1103910)
• The dynamic modification of the color attributes from an EBCDIC COBOL program will now be honored.

Dynamically modifying extended attributes such as color and field highlighting works regardless of the
code base, ASCII or EBCDIC of the COBOL program.

2853509 (1103505)
• LU3-type printing from IMS transactions is no longer unexpectedly truncated.

2853494 (1103437)
• If the MFS specifies that the print line should have spaces stripped, then all spaces following the last

significant data byte will be removed.

2853493 (1103436)
• IMS system commands and paging requests will be honored when they occur in segments other than

the first and the preceding segments contain all NULLS.

2852124 (1103551)
• The MFS PROMPT keyword in MFS source is now supported.

2818114 (1099103)

• On a successful IMS CHNG call, a corrupted EBCDIC PCB name in ALT-IO PCB was sometimes
generated. This has been fixed to generate a valid EBCIDIC name.

2857243 (1104018)

• RTS 114 errors no longer occur when printing from an IMS transaction while the printer is disconnected.

2857604 (1104070)
• Printing from an IMS transaction no longer fails to print when the printer is not connected until after the

print request has already been sent by the transaction.

2857603 (1104068)
• Printing a large number of pages from an IMS transaction no longer causes the transaction to abend.

2848152 (1102799)
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• Submitting a /FORMAT command with data no longer abends with a Run-Time System error 114.

2847486 (1102797)
• A new Enterprise Server environment variable, ES_IMS_GOTO_CICS_ON_SIGNOFF, has been added

in this release. Set ES_IMS_GOTO_CICS_ON_SIGNOFF=Y to return users to CICS upon logging off or
timing out, rather than returning them to the IMS sign-on screen, which is the default behavior.

2836417 (1102541)
• A problem with incorrectly formatted output data appearing on IMS screens when default literals or

system literals were assigned to output message fields has been fixed.

2825068 (1100049)

Interface Mapping Toolkit

Back to the list

• Client generation now works as expected when invoked from the Team Developer Tree View.

2869050 (1105758)
• A Web Services folder is now created when creating a web service in a COBOL remote project,

specifying CREATEXFD as an additional project directive.

2849983 (1103157)

JCL Support

Back to the list

• You no longer receive a U4038 abend when calling MFJZLPSA with a JCL that uses DFSRRC00 and
BMP.

2869477 (1105804)
• The IEBPTPCH utility now checks against code page 0290 for printable characters when running with

MF_CHARSET=EBCDIC and MFCODESET=9122.

2867654 (1105531)
• An incorrect reason code was returned by mvscatpb when deleting a record in a user catalog.

2866782 (1105384)
• Previously, when the output or output-hold job record was selected in ESMAC and deleted, the physical

spool files would be left.

2865754 (1105269)
• Under VSE, when the environment variable ES_SAM_ESDS is set to Y, an open OUTPUT of a reusable

ESDS file resets the file in situations when the DISP is not specified in the DLBL statement.

2865599 (1105186)
• The catalog list function now returns correct results when user catalogs exist.

2865225 (1105120)
• Allocation overrides can be applied to a GDG model, and each GDG bias will use the folder location for

the physical file.

2865068 (1105102)
• You can now use the environment variables MF_SPOOL_HK_OUTPRT and

MF_SPOOL_HK_LEX_SCAN with the MVSSPLHK spool housekeeping utility. The values can also be
used in the utility configuration file.

2864993 (1105088)
• A problem with the initialization of the JCL job number caused a hang on a region startup.

2863640 (1104883)
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• The mvscatpb public interface was missing the secondary space value and the directory blocks value.

2860753 (1104483)
• The JCL user exit is now being called for the event step-bypassed.

2857924 (1104130)
• A time-expired spool file will not be removed from the MVS Spool or the catalog if a record still exists in

casspool.

2857452 (1104079)
• The JES000915E error message now shows the correct userid.

2856571 (1103927)
• Some issues that resulted in receiving sporadic locked record errors in the spool housekeeping utility

have been fixed.

2855421 (1103730)
• DD DUMMY overrides are now correctly processed in concatenated SORT statements.

2853452 (1103435)
• The record locking and reporting has been improved.

2853344 (1103438)
• The archived files report of the MVSSPLHK utility, INDEXO, will now be populated when DATA-only

archiving is requested. The class-specific overrides are now applied.

2853244 (1103544)
• The SYSOUT messages produced when the MVSSPLHK program was writing to an EBCDIC file were

corrupt.

2852020 (1103718)
• The JCL job restart error messages for some of the known error codes now provide more specific

details.

2851945 (1103293)
• IF the SYSUT2 DCB information is missing, IEBGENER now copies the DCB from SYSUT1 to SYSUT2

even when SYSUT2 is specified as a SYSOUT dataset.

2851861 (1103357)
• When using a DUMMY input file for IDCAMS operations, the dataset properties from a previous

operation could still be set.

2851041 (1103192)
• When calling MVSSPLHK from user programs, the passed parameters are now respected.

2850869 (1103135)
• A warning will be displayed in situations where a wildcard is used in the IDCAMS DELETE function and

a non-empty GDG base is encountered. This will not stop the deletion of other datasets.

2849270 (620072)
• IEBCOPY now correctly copies the DCB attributes from INDD to OUTDD in situations where the

OUTDD DCB information is missing from the job.

2844219 (1102265)
• ICEGENER and IEBGENER now support PDS members with names that start with numbers.

2843583 (1102530)
• There is a new environment variable, ES_SSTM_JOB_FLUSH_ACTIVE. When this is set to Y, CICS

SSTM job will be removed from the ACTIVE queue when the region shuts down.

2843520 (1102320)
• If a non-optional file is opened and it is present but virgin, the product returns a 3/5 status.

2832909 (616390)
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• Cataloged spool records are no longer removed if a corresponding casspool record still exists.

2832909 (1103892)
• IDCAMS REPRO now only requires "UPDATE" permissions in order to write to existing DSNs.

2824128 (1100133)
• If a PDS has no members, IEBCOPY now reports that no members were found and does not change

the COND CODE. Previously the COND CODE was set to 4.

2810006 (1098237)
• Square brackets are now supported in MFUSERCAT_NODE.

2514366 (1105505)
• The incorrect character encoding was used when a PL/I program allocated a dataset using SVC99.
• When using multiple catalogs, entries from the last catalog were not always found or displayed when

performing a listing.
• Any JESDS OUTPUT statements are now passed to the printer exit if the JCL job log, JESYSMSG, is

printed.

• The Job Detail and Catalog Entry pages now support the Shift JIS character encoding. The information
about the character encoding of the Operating System is retrieved from the region and if it is Shift JIS
these pages will now correctly display it.

2853227 (1103407)
• The Management Class (MGMTCLAS) is now displayed on the Catalog Entry page.

2581463 (1085180)

• To prevent interference with MFFTP execution when running under VSE, edit the VSE configuration file
USE-SYSIN section for MFFTP and assign the permenant instream DD name to SYSIPT (IPTSYS).

2864865 (1105434)
• Jobname information is no longer carried forward from one VSE job to the successive jobs.

2864594 (1105072)
• A problem processing PAUSE statements in DOS/VSE has been corrected.

2862396 (1104715)
• A problem with SETPARM incorrectly assigning a symbolic parameter value has been fixed.

2858580 (1104411)
• A SYSIPT read error that occurred when no input data was included in JCL has been changed to return

an EOF instead as is done on the mainframe.

2858377 (1104199)
• DLBL allocations before PAUSE statements are no longer lost.

2856861 (1104732)
• The maximum number of characters in comments in VSE PAUSE statements has been increased from

44 to 71.

2856412 (1103937)
• MFFTP now handles both SYSIPT(VSE) and INPUT(JES2) DD statements for FTP commands.

2855714 (1104139)

Licensing

Back to the list

• The SafeNet installer now uses tar instead of PaX. This is to ensure compatibility across platforms.

2860254 (1104400)
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Mainframe Access

Back to the list

• Output from the MFDAS GETENQI command now contains line feeds.

2860316 (1104413)

• When MFA dependent ASIDs terminated, the message IEF352I was issued "ADDRESS SPACE
UNAVAILABLE". This could lead to the system running out of ASIDs. This has now been fixed.

2856313 (1103876)
• Web sites that validate the APPL when passwords are verified no longer reject logons from MFA.

2850696 (1103118)
• Mainframe Access now successfully imports and exports binary files that have LRECLs greater than 80

bytes.

2846536 (1102617)

• The directory listing for Panvalet libraries now contains the member status flags.

2850501 (1103099)

• It is now possible to export files greater than 2 GB in length from a MFA client to a mainframe.

2860982 (1105964)
• Unloaded IMS databases larger than 64Kb were corrupted when imported.

2856795 (1104303)

Mainframe Batch Scheduler Integration

Back to the list

• The MFBSI Control-M AutoEdit emulation is now ignoring the IF/ELSE statements block when the
condition is false.

2863481 (1104860)
• The default delays used by MFBSIJCL to check for a job state in Enterprise Server are as follows - two

seconds before each check for "Job Started" and ten seconds before each check for "Job Concluded". It
is now possible to configure these delays in the MFBSI configuration file, mfbsi.cfg, with the following
two new parameters - JOBSTART-LOOKUP-FREQ and JOBEND-LOOKUP-FREQ. Both parameters
accept values between 1 and 60 (in seconds), and AUTO. When AUTO is used, MFBSIJCL uses an
initial frequency of one second for three minutes after which the default values are restored. Using these
parameters will significantly reduce the overhead elapsed time in MFBSIJCL when compared to the
Enterprise Server JCL reported execution time of a job. This has an effect mainly in scenarios when you
have short-running jobs that are frequently executed.

2857416 (1105116)

Micro Focus Directory Server

Back to the list

• Fixed an issue where XA open string which included the "=" character would not display correctly in the
Enterprise Server Administration HTML GUI.

2856722 (1103958)
• If a user attempts to login to the MFDS process using a valid ID but an invalid password the message

"ML3073W Unknown user" is no longer logged in the MFDS journal output.

2842321 (1102116)
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MVS REXX Emulation

Back to the list

• This release provides a technology preview support for the DSNREXX commands for DB2 LUW.

2842140 (1102170)

OpenESQL

Back to the list

• A problem with SQL(SQLCLRTRANS) that caused a COBOL 173 runtime error on stored procedures
that make COBOL calls to other modules has been fixed.

2871330 (1106084)
• A problem using SQL(CHECK) with statements that contain a FOR :hostVariable prefix has been fixed.

2868823 (1105704)
• In managed code only, a problem with the OpenESQL preprocessor sometimes generating incorrect

code after a stored procedure call resulted in some data being returned incorrectly. This has been fixed.

2868405 (1105663)
• Compiler errors sometimes resulted when the SQLCLR wrapper generator generated duplicate

parameter names. This has been fixed by updating the generator to check for the potential of duplicate
names and choose an alternate extension to insure unique names.

2866086 (1105262)
• The OpenESQL pre-compiler incorrectly generated code for programs compiled with

CHARSET(EBCDIC) and SQL(DBMAN=ADO) when SQL statements were greater than 4000
characters.

2864850 (1105064)
• Previously, the SPD Generator did not handle correctly some of the parameters which resulted in

generating an incorrect COBOL code.

2864348 (1104993)
• The OpenESQL component was updated to resolve an issue executing the HCOSS Assess Application

Migration tool when either no Visual Studio product was installed, or just the Visual Studio Integrated
Shell was installed.

2864021 (1104951)
• The SPD generator incorrectly handled quotes around the procedure name, resulting in a compile error

of generated COBOL code. This has been corrected.

2863699 (1104906)
• HCOSS was improperly handling UPDATE statements that uses row constructors based on a subquery.

This has been fixed.

2860329 (1104628)
• Using SQL(DETECTDATE=SERVER) with queries containing single quote characters sometimes

resulted in an error. This has been fixed.

2857619 (1104103)
• The DCLGEN function of OpenESQL Assistant now supports including comments in copybooks for the

Label extended properties on SQL Server columns.

2856215 (1104118)
• The SQL(CHECKSP) Compiler directive has been added to list of directives which you can set from the

project's or a file's properties. Also, receiving an error message that the SPD file was not found no
longer causes compiling to hang.

2853668 (1103454)
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PL/I Support

Back to the list

• A problem when using SUBSTR as an argument to UPPERCASE has been fixed.

2863064 (1104802)

• A problem with initialization of structures containing a CHAR(0) member has been fixed.

2868923 (1105719)
• A problem with passing an unconnected array reference to an argument with CONNECTED in its

descriptor has been fixed.

2868606 (1105886)
• The compiler now diagnoses PICTURE specifications which cause internal compiler implementation

limits to be exceeded.

2868176 (1105602)
• A problem with GRAPHIC concatenation causing a SIGSEGV has been fixed.

2867892 (1105565)
• ? ?roblem with an ENTRY invocation without () has been fixed.

2867705 (1105540)
• A problem with a comparison of a BIT(1) to a numeric literal or FIXED BINARY variable has been fixed.

2866657 (1105363)
• A possible problem with the scoping of implicit and contextual declarations has been corrected.

2865207 (1105109)
• The diagnostic message MFPLI00176S when issued erroneously has been fixed. The text of the

diagnostic has also been corrected and changed to W-level.

2864859 (1105066)
• When SQL compilation phase terminates with "Severe errors have been detected during initialization

(FERC=12)", a .list file (or .lst file on Windows) is now created which contains the Severe diagnostic
messages. Note: The -l option must be supplied to mfplx, or if using an IDE, you must select Generate
listing file (-l) via the PL/I Compile settings.

2863419 (1104854)
• A problem with -agginit used in conjunction LIKE erroneously causing Error MFPLI00126E has been

fixed.

2862202 (1104697)
• A problem with CTL structures which contain Fixed Bin(7) arrays causing a compiler Abort MFPLI2000A

with an internal consistency error has been fixed.

2861581 (1104616)
• A problem using a function reference in an INIT clause has been fixed.

2860769 (1104496)
• A problem diagnosing structures declared with LIKE, and inheriting the CONNECTED (or

NONCONNECTED) attribute, has been fixed.

2860742 (1104489)
• A problem with EBCDIC conversion of string literals under the Japanese locale has been corrected.

2859505 (1104311)
• A problem with CTL storage and structure expressions has been fixed. This problem caused

unexpected side-effects, for example, structure assignments with BY NAME causing internal compiler
errors.

2859473 (1104309)
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• A problem causing an error diagnostic to not be shown in the Eclipse IDE has been fixed.

2858299 (1104180)
• A DEFINED overlay with bit-strings erroneously diagnosed as invalid has been corrected.

2857736 (1104086)
• The compiler now diagnoses PUT DATA without an argument list as unsupported.

2857371 (1104051)
• The compiler now does a compile-time check for invalid constant conversions, and provides a Warning

diagnostic to help preempt invalid conversions at run-time.

2854530 (1103602)
• A problem assigning unconnected arrays has been fixed.

2850898 (1103139)
• Bit-field alignment within structures when applying Z/OS mapping rules (-zalign) have been corrected.

2843898 (1102241)
• The Open/PLI compiler now supports STATIC initialization of FILE variables and ENTRY variables.

LABEL variables cannot be initialized at compile-time and an appropriate diagnostic is issued.

2841654 (1102011)
• The compiler now supports initializing static pointer variables to the address of another static variable at

compile time. For example: dcl x fixed bin (31) static; dcl p pointer static initial(addr(x));

2841649 (1101974)

• Previously, if macro code was poorly written and did not contain matching %DO-%END groups, a loop
and/or trap could occur after a message was generated indicating this "Severe" error. The logic in the
macro preprocessor has been modified to issue the message and stop trying to process the macro
code.

2862937 (1104776)
• Previously, if you were using a PL/I macro to generate code that contained exponentiation and in the

generated code the exponentiation symbol ended up on column 71/72, the symbol was split to the next
line. This no longer occurs.

2860875 (1104505)
• Previously, if a macro contained a %DO;-%END; group and -margins 2,72 option was in effect, and the

source contained an asterisk in column 72 immediately followed by the %END; beginning in column 2 of
the following line, then the diagnostic was incorrectly generated. This no longer happens.

2857346 (1104034)
• Previously, if using the macro ANSWER statement within a DO loop, the macro preprocessor would not

emit a complete preprocessed source deck. This no longer happens.

(619151)

• Previously, if reading SYSIN via a PL/I Program compiled with -ebcdic, from a physical dataset in an
enterprise server region running in EBCDIC mode, the input was garbled. This no longer occurs.

2865346 (1105128)
• Previously, if using PUT SKIP(x) where x is greater than 1, on the first line of the first page of a PRINT

CTLASA file, the use of ASA control characters did not mimic the undocumented behavior present in
IBM's PL/I on z/OS. This has now been fixed.

2864096 (1104958)
• Previously, when a CTLASA file was OPEN(ed) and CLOSE(ed) without any data being written, a zero

length file was created. Open PL/I now matches IBM's behavior and emits a single blank page feed line.

2863818 (1104911)
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• Previously, if using an EXTFH.CFG where the [XFH-DEFAULT] contained INSERTNULL=OFF, the
compiler would trap when compiling larger complex programs while attempting to read back in a
temporary file created during the parsing phase. This no longer occurs.

2863220 (1105599)
• The PL/I compiler and run time have been enhanced to support the SAMEKEY() built-in function.

2860459 (1104456)
• Previously, if an ERROR condition was triggered in a PL/I CICS user program and the user program did

not contain its own ON ERROR unit, the PL/I RTS error messages were not driven to the CPLI
temporary data queue. This has now been fixed.

2851930 (1103255)
• A problem printing bit fields within structures has been corrected.

• Previously, the EXEC preprocessor was unable to handle a hex literal constant that exceeded 255 bytes
in length. This has now been fixed.

2861454 (1104591)

Run-Time System

Back to the list

• A statement "MOVE <justified-alphanumeric-item> TO <numeric-item>" no longer produces a
COBRT200 error.

2869985 (1105986)
• If the Audit Manager was under heavy load by many client processes and was then re-cycled, it was

possible that the client processes would not send the correct details when attaching to the new Audit
Manager process, which would cause Audit Manager to crash. This is now fixed.

2863509 (1104863)
• Pasting of DBCS characters that have a 2nd byte of x"E0" is now working correctly.

2861398 (1104580)
• A dynamically bound application DLL that uses Object COBOL no longer hangs intermittently when

loaded concurrently in multiple threads.

2858271 (1104328)
• An additional sub-function has been added to the CBL_GET_PROGRAM_INFO library routine. The

sub-function, number 10, returns a program's full path, or name only, depending on flag settings.

(618769)
• Detaching from animation that was started using the debug_on_error tunable could cause animation to

re-start again for the initial error - this has now been resolved.

Setup

Back to the list

• The UNIX setup file now supports the SuSE 12 SP1 version of spax.

2866227 (1105283)
• The Install.sh script now performs the correct disk space checks to determine if there is enough space

on SOLARIS SPARC machines prior to installing.

2854557 (1103628)

SQL: Cobsql

Back to the list
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• A problem with processing an SQL statement when it was on the same line as a COBOL condition
resulted in a CSQL-F-026 error. This has been fixed.

2864989 (1105085)
• A problem with COBSQL incorrectly handling EXEC SQL INCLUDE statements has been fixed.

2821960 (1099586)
• A problem with COBSQL not recognizing or properly processing a section that comes directly after

comment lines and returning an error has been fixed.

2818934 (1099169)
• A problem with COBSQL not properly invoking cobpre64 when COBSQLTYPE is set to SYBASE has

been fixed.

2794407 (1096173)

SQL: DB2 ECM

Back to the list

• A problem with the HCO import tool incorrectly handling packed decimals greater than 18 digits has
been fixed.It has been updated to now handle packed decimals up to 26 digits.

2866180 (1105278)
• The DB2 pre-compiler sometimes incorrectly restored the RETURN-CODE after a SQL statement was

executed.

2857403 (1104045)

SQL: HCO for SQL Server

Back to the list

• An HCOSS problem with statements of the form 'SELECT ... FROM ( (SELECT ...) ...), that is, a table
reference using a nested query that is itself in parentheses, has been fixed with the new STRICTPARSE
SQL compiler directive option. Use STRICTPARSE with DIALECT=MAINFRAME to enhance
diagnostics for DB2 statements that HCOSS does not recognize.

2868603 (1105683)
• An issue with HOCSS handling comparison operators that include angle bracket characters has been

fixed.

2867541 (1105520)
• An issue that occurred when HCOSS was processing an IN expression using a row constructor in a

nested subquery has been fixed.

2867264 (1105519)
• A few issues with the HCOSS emulation of DB2's CHAR scalar function in the formatting date and time

values as character strings have been resolved.

2861301 (1104596)
• A problem with SQL(CHECK) for DBMAN=ODBC with queries where the reserved word INNER

immediately follows a host variable has been fixed.

2855930 (1103815)
• A problem qualifying sequence names when using SQL(DIALECT=MAINFRAME) and

SQL(QUALIFIER) has been fixed to qualify sequence names in the same manner as as table names
are qualified.

2854747 (1103654)
• The Generate SPD File tool generated incorrect code if the name of a called routine was enclosed in

single quotes; this resulted in COBRT173 error when the code was executed.

2853692 (1103481)
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• The HCOSS Transfer Data tool has been updated to support SQL Server 2016.
• A problem with HCOSS incorrectly handling DROP statements when SQL(QUALIFIER) is used has

been fixed.

SQL: OpenESQL

Back to the list

• The INSENSITIVE option is no longer available for the STATICREADONLY directive.

2871907 (1106251)
• A problem with error message handling in the ODBC run time for SAVEPOINT statements has been

fixed.

2870141 (1105889)
• A problem with HCOSS incorrectly renaming parenthesized expressions in select lists has been fixed.

2869320 (1105787)
• SQL(SPTHROWEXCPETION) now throws an exception only for errors that result when SQL Server

terminates the current transaction.

2868965 (1105736)
• SQL(DETECTDATE) would sometimes incorrectly match dates and times in European and USA

formats.

2868282 (1105622)
• A problem with the OpenESQL preprocessor failing to properly check the length of an SQL statement

properly, resulting in a 153 RTS error, has been fixed.

2867772 (1105549)
• A problem with OpenESQL SQL Entry and Exit not showing in trace output has been fixed. The trace

output is now sent to Auxiliary trace during CICS transaction execution.

2867423 (1105490)
• A problem running SQL CLR stored procedures on heavily loaded servers has been fixed.

2865750 (1105229)
• A problem with OpenESQL allocating duplicate server cursor names for positioned updates in stored

procedures has been fixed.

2865750 (1105230)
• A problem with the OpenESQL Assistant generating copybooks with TINYINT columns as PIC S9(2)

COMP-5 rather than PIC S9(4) COMP-5 has been fixed.

2865378 (1105139)
• HCOSS now correctly handles hexadecimal constant strings.

2865026 (1105146)
• A problem with the OpenESQL preprocessor when compiling with the CHARSET(EBCDIC) directive

sometimes generating COBCH0002/COBCH0302 compilation errors for programs that used arrays as
host variables in SQL statements has been fixed.

2864585 (1105039)
• OpenESQL now supports DESCRIBE CURSOR statements.

2863839 (1104939)
• A problem with HCOSS handling the SUBSTRING function when only three parameters are supplied

has been fixed.

2862754 (1105122)
• HCOSS now correctly handles the DB2 TRUNCATE scalar function when the function is called with only

one parameter.
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2862064 (1104674)
• HCOSS could sometimes report a SQL(CHECK) error as a warning instead of an error.

2861897 (1104668)
• The ODBC pre-compiler now swaps array variables using DO UNTIL loops similarly to how it does this

for COBOL. This considerably reduces the number of statements generated for array variables.

2861580 (1104613)
• HCOSS now correctly sets SQLCODE = 100 for a rowset fetch that retrieves fewer rows than the host

array size.

2861570 (1104629)
• HCOSS now handles correctly FETCH FIRST and ORDER BY clauses in queries that use set

operators.

2861567 (1104751)
• A problem with OpenESQL incorrectly handling DB CAST expressions that use FOR BIT DATA has

been fixed.

2861516 (1104689)
• HCOSS no longer trims trailing spaces automatically from input host variables when

SQL(DIALECT=MAINFRAME) is set.

2859565 (1104692)
• Previously, you could incorrectly receive truncation warnings for output parameters of Oracle stored

procedure calls that are character fields narrower than 19 characters.

2859200 (1104598)
• Using MySQL ODBC 5.6 or later with OpenESQL in VC/ED 2.3 or later caused an RTS 114 error. This

has been fixed.

2858980 (1105338)
• Problems with the OpenESQL Assistant that caused the "no columns in table" error have been fixed.

2856643 (1103936)
• A problem with applications compiled with the SQL(INIT=PROT) directive caused Enterprise

Server .NET jobs to hang. This has been fixed.

2856198 (1104002)
• HCOSS now supports DB2 RELEASE SAVEPOINT statements and problems with global temporary

table housekeeping and ROLLBACK TO SAVEPOINT statements have been fixed.

2856008 (1103831)
• The SPTHROWEXCEPTION SQL compiler directive option has been added to improve diagnostics

returned to calling applications from COBOL SQL CLR stored procedures in the case of an implicit SQL
Server rollback on a transaction.

2854780 (1103670)
• A problem with OpenESQL not allowing 'NO' to be used as an SQL identifier has been fixed.

2854592 (1103598)
• A problem with the JDBC runtime incorrectly setting SQLCODE on repeat execution of EXECUTE

IMMEDIATE statements has been fixed.

2854393 (1103713)
• A problem processing the EXEC ADO DATATABLE <name> BIND statement resulted in a COBES0100

error. This has been fixed.

2854004 (1103529)
• Some problems with DB2-style result sets where allocated cursors are reused without being closed and

where cursors must remain open across multiple calls to the same stored procedure have been fixed.

2853859 (1103520)
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• EXCEL table names enclosed in single quotes were incorrectly handled by the DCLGEN function of the
OpenESQL Assistant, resulting in an unhandled exception. This has been fixed.

2853832 (1103555)
• The COBOL Run-Time system now successfully loads the ODBCRW64.DLL file when a native COBOL

application is being called from a C# application.

2853578 (1104167)
• The OpenESQL directives SQLCLRTRANS and SPDISPLAY now work correctly for Enterprise

Server.NET batch jobs.

2853439 (1103430)
• An HCOSS problem transforming SQL statements that contain both XML and CONCAT operators has

been fixed.

2853412 (1103426)
• The OpenESQL ODBC runtime has been updated to ensure that connections are closed after a

DISCONNECT.

2853341 (1103461)
• HCOSS now correctly handles WITH DEFAULT clauses in table definitions that do not specify a default

value.

2852996 (1103431)
• HCOSS now supports DB2 DECLARE GLOBAL TEMPORARY TABLE statements that use AS <query>

and LIKE <tableName>.

2850369 (1103793)
• The SQL(PROCOB) directive option for the OpenESQL preprocessor now supports Pro*COBOL's

syntax for calling database functions when SQL(DBMAN=ADO) is also set. In addition, a problem that
prevented DML from being executed in user-defined functions has been fixed.

2849318 (1102957)
• The SQL(PROCOB) directive option for the OpenESQL preprocessor has been updated to process

Oracle grouped host array syntax.

2849301 (1102956)
• To fix a problem with the DETECTDATE directive not allowing runtime control of datetime data

formatting, the OpenESQL SET <hostvariable> and SET OPTION statements have been enhanced to
allow datetime data formatting behavior equivalent to the OpenESQL DATE, TIME, DATEDELIM,
TIMEDELIM, TSTAMPSEP, and DETECTDATE directives.

• A problem with positioned update when using the latest release of the PostgreSQL ADO.NET provider
has been fixed.

• The namespace used by the JDBC runtime for OpenESQL has changed from
MicroFocus.COBOL.SqlJVM to com.microfocus.openesql.

• The 32-bit Windows DLL names used in OpenESQL JES program-alias mapping have been changed
as follows: SQLTP232 to SQLTP2 SQLUTB32 to SQLUTB.

• Using the CHARSET(EBCDIC) directive with OpenESQL sometimes caused the preprocessor to
generate incorrect code for converting SQLCA fields, resulting in CONNECT failures. This has been
fixed.

• The SET host-variable embedded SQL statement has been added to OpenESQL to enable you to
query the current connection name and database type.

• Cursor prefetch behavior in OpenESQL has been made more consistent with updates to the
PF_RO_CURSOR and PF_UPD_CURSOR primitive compiler directive options for BEHAVIOR, and the
MARS compiler directive option. See your product documentation for complete details.

SQL Option for DB2

Back to the list
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• The SQLN value in SQLDA is no longer modified when a FETCH is performed using invalid SQLVAR
SQLDATA pointers.

2854157 (1103541)

• A Run-Time System error "-84 UNACCEPTABLE SQL statement" could occur when there was a
VARCHAR host variable definition with an extra 49 level FILLER statement.

2867096 (1105432)
• Modified the XDB precompiler to no longer generate COBSQ0413S errors if the program is compiled

with directive XDB(BEHAVIOR=STACKED).

2855151 (1103687)

• The XDBSetup utility supports creating a user XDB.INI in the user's local application space.

2839228 (1101904)

• An issue with scalar functions invoking aggregate functions invoking more scalar functions with
embedded host variables has been fixed.

2869971 (1105862)
• A problem that resulted in XDB Server providing incorrect SORT results when using ROWSET

POSITIONING has been fixed.

2867209 (1105454)
• Implicit casting is now carried out for SUBSTR() arguments in the V10 XDB engine.

2865204 (1105108)
• A problem with uninitialized query common space generating an illegal decimal data error has been

resolved.

2860427 (1104449)
• XDB Server has been updated to correctly return results from XDB SQL when certain statement

combinations are executed.

2856158 (1103932)
• Some SQL queries that return data on the mainframe did not return data in XDB. These queries now

return data in XDB as well.

2853378 (1103442)
• The XDB SQL optimizer has been updated to use a new compound index routine. This corrects a

problem that caused a thread access violation when processing a very large join restriction queue that
had overflowed to disk.

2853078 (1103385)
• A problem with the XDB server corrupting a row after executing a program that uses a FOR UPDATE

cursor has been fixed.

2850725 (1103117)
• Multiple issues that occurred when the reserved word SELECT was used as an identifier have been

resolved.

2849898 (1103024)
• A problem causing the SQL result to be inconsistent when using the SELECT... IN clause has been

fixed.

2849892 (1103103)
• A problem when creating a unique index, that resulted in an "x020: Syntax error. Last symbol read was

'INCLUDE'" error message, has been fixed.

2847745 (1102766)
• SQL Option now supports PARTITION BY SIZE syntax for DB2 version 9.

2845161 (1102494)
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• XDB no longer throws an X405 error message when it encounters a NOT operator that is part of a
compound predicate.

2640689 (1088784)

XML Syntax Support

Back to the list

• In some scenarios, XMLPARSE returned an RTS 114 error while parsing certain XML documents.

2851143 (1103185)
• When reading an empty XML document, the returned file status is now -7.

2851074 (1103216)

z/Server

Back to the list

• When exporting a file with records longer that the LRECL of the receiving data set, the record will now
be truncated rather than aborting the transfer and leaving a short member. The client will also notify the
user that truncation has occurred.

2860057 (1104444)
• z/OS system names starting with a digit will no longer result in bad console names being created.

2855175 (1103737)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2865238 (1105114)
• 2871930 (1106185)
• 2866567 (1105346)
• 2865516 (1105153)
• 2865065 (1105097)
• 2857117 (1104003)
• 2872217 (1106234)
• 2864576 (1105124)
• 2855891 (1103807)
• 2864100 (1104959)
• 2867120 (1105479)
• 2865687 (1105211)
• 2864343 (1105019)
• 2858008 (1104163)
• 2858007 (1104161)
• 2835721 (1101500)
• 2835605 (1101499)
• 2858091 (1104136)
• 2865419 (1105238)
• 2864875 (1105074)
• 2861263 (1104753)
• 2859986 (1104407)
• 2855942 (1103906)
• 2679133 (1093595)
• 2852255 (1104353)
• 2856233 (1103855)
• 2867934 (1105578)
• 2867215 (1105455)
• 2866174 (1105419)
• 2858808 (1104227)
• 2855088 (1103672)
• 2853477 (1103462)
• 2852874 (1103543)
• 2839669 (1101704)
• 2836259 (1101305)
• 2808029 (1098883)
• 2790796 (1095836)
• 2854829 (1103653)
• 2854739 (1103627)
• 2866458 (1105348)
• 2865807 (1105205)
• 2864327 (1104989)
• 2862599 (1104785)
• 2848016 (1102774)
• 2843761 (1102734)
• 2841092 (1101887)

• 2865193 (1105135)
• 2864092 (1106070)
• 2859740 (1104343)
• 2859539 (1104350)
• 2856245 (1103972)
• 2855704 (1104105)
• 2855440 (1103871)
• 2853585 (1103448)
• 2852872 (1103696)
• 2852872 (1103930)
• 2852872 (1103931)
• 2851306 (1103352)
• 2840161 (1101839)
• 2799183 (1096680)
• 2863024 (1104786)
• 2853074 (1103489)
• 2848947 (1103100)
• 2816310 (1104173)
• 2859923 (1104371)
• 2650949 (1090062)
• 2854470 (1103640)
• 2857870 (1104107)
• 2809343 (1099937)
• 2858035 (1104156)
• 2856499 (1104222)
• 2857318 (1104188)
• 2858539 (1104204)
• 2856795 (1103963)
• 2840704 (1103249)
• 2863482 (1104862)
• 2861561 (1104610)
• 2860719 (1104512)
• 2858941 (1104253)
• 2858723 (1104229)
• 2856941 (1103977)
• 2856206 (1103880)
• 2861649 (1104679)
• 2853710 (1103578)
• 2867842 (1105600)
• 2865028 (1105119)
• 2860212 (1104480)
• 2854400 (1103587)
• 2852486 (1103340)
• 2842820 (1103533)
• 2855179 (1103705)
• 2855179 (1103707)

• 2819868 (1099861)
• 2865350 (1105129)
• 2864599 (1105025)
• 2853376 (1103486)
• 2855231 (1103701)
• 2870740 (1106000)
• 2858161 (1104152)
• 2864758 (1105772)
• 2856295 (1103875)
• 2839181 (1101830)
• 2864619 (1105054)
• 2861296 (1104593)
• 2860006 (1104387)
• 2854108 (1104290)
• 2848917 (1103264)
• 2838891 (1101791)
• 2648290 (1089566)
• 2864197 (1105004)
• 2852655 (1103333)
• 2869703 (1105832)
• 2869126 (1105760)
• 2852996 (1103913)
• 2859001 (1104312)
• 2869594 (1105948)
• 2867462 (1105499)
• 2866779 (1105567)
• 2865650 (1105214)
• 2865630 (1105243)
• 2865078 (1105100)
• 2865051 (1105317)
• 2865003 (1105132)
• 2863175 (1104845)
• 2860863 (1104746)
• 2860785 (1104563)
• 2859507 (1104314)
• 2859155 (1104316)
• 2859044 (1104282)
• 2857023 (1104176)
• 2857021 (1103995)
• 2856592 (1104053)
• 2852281 (1103298)
• 2818259 (1099422)
• 2865602 (1105177)
• 2863239 (1105044)
• 2861423 (1104585)
• 2858787 (1104233)
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• 2869763 (1105896) • 2851107 (1103173)
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Installation

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

The disk space requirements for Windows are, approximately:

Enterprise Developer Sentinel RMS License Manager

4.5GB 75MB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.

z/Server requirements

z/Server has the following hardware requirements:

• IBM mainframe model z9 or later is required for installing and using z/Server. z/Server will not install on
earlier hardware models.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• Enterprise Developer enables you to produce both 64-bit and 32-bit applications on 64-bit
operating systems.

• This product can be installed on earlier versions of Windows but it has not been tested on them.
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Software requirements

Note: This product includes OpenSSL version 1.0.1p.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Eclipse requirements

• The setup file installs Enterprise Developer and Eclipse 4.4.2.

See Installing Enterprise Developer into other instances of Eclipse for instructions on how to install
Enterprise Developer into other instances of Eclipse installed on your machine.

Note: If you are installing Enterprise Developer into Eclipse 4.5, you must install the Eclipse Target
Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):

1. Click Help > Install New Software in your Eclipse 4.5 and add a new repository for the location
http://download.eclipse.org/tm/updates/4.0.

2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.

• Enterprise Developer does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to
create both 32-bit and 64-bit applications.

• Enterprise Developer requires a 32-bit Java installation.

Software requirements on Windows

• Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from 
Oracle's web site and install it anywhere on your machine.

Note: If Java 7 is installed on your machine, to skip installing Java 8, run the Setup file with the
skipjre=1 command line option.

• The setup file also installs .NET Framework v4.5.2 and the Microsoft Visual C++ 2010 and 2012
Redistributables.

See the Java Support Considerations for the Eclipse IDE in the Known Issues and Restrictions section in
your product help for considerations that apply to using the Eclipse IDE and Java.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.
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Click here to see this information in the Micro Focus Infocenter.

Product Co-Existence
Note: The following applies to Windows only.

• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

On UNIX

System Requirements for Micro Focus Enterprise Developer UNIX
Components
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Hardware Requirements

The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

POWER
running AIX

Micro Focus installer 479 1.91 GB 958 36.5

HP IA Micro Focus installer 866 3.46 GB 1.73 GB 69

System Z
running Red
Hat Linux

Micro Focus installer 390 1.56 GB 780 36

x86-64
running Red
Hat Linux

Micro Focus installer 431 1.72 GB 862 46

SPARC
running
Solaris

Micro Focus installer 492 1.97 GB 984 40

System Z
running SUSE
SLES

Micro Focus installer 394 1.58 GB 788 36

x86-64
running SUSE
SLES

Micro Focus installer 437 1.75 GB 874 46

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements for Micro Focus Enterprise Developer UNIX Components

These are the software requirements for Micro Focus Enterprise Developer UNIX Components:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

glibc-locale-32bit X X

glibc-*.x86_64 X X

glibc-*.i686 X X

libgcc-*.x86_64 X X

Installation | 51

http://supportline.microfocus.com/prodavail.aspx


Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

libgcc-*.i686 X X

libstdc++-*.x86_64 X X

libstdc++-*.i686 X X

gdb* X X X X

elfutils-libelf-** X X X X

libelf-
devel-0.137-8.19
**

X X X X

libelf1-0.137-8.19*
*

X X X X

libelf1-32bit-0.137-
8.19**

X X X X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The setup file installs Java
8 u51 32-bit. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute COBOL JVM code, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true
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Additional Software Requirements for Micro Focus Enterprise Developer UNIX Components

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

Click here to see this information on the Micro Focus Infocenter.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Enterprise Developer for Eclipse. When
you start the installation, if the 64-bit version of Java is already installed on your Linux machine, you might
not be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux
which prevent you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To
work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and

run Enterprise Developer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing on Windows
Note:

• This version of the product is a full install.
• If you have an earlier version of Enterprise Developer installed on your machine, check Installing

as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:

1. Run the ede_232.exe file and follow the wizard instructions to complete the installation.
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By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.4.2, with the Micro Focus
plugins already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse
directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have Java 7 installed on your machine and you want to skip installing Java 8, run the
setup file from the command line with the skipjre=1 command line option.

Installing Micro Focus Enterprise Developer UNIX
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.3_update2_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.3_update2_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_2.3_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

54 | Installation



Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter
• Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus

Infocenter
• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus

Infocenter
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

RDz, z/Server - available in the product Help and in the Micro Focus Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Micro Focus Infocenter.

On Windows

Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.

• If you have been using the mainframe components of Enterprise Developer for z Systems, see Installing
z/Server as an Upgrade for recommendations about how to upgrade your z/Server installation. Also,
check Backward Compatibility of AWM Models for information about changes that affect your existing
AWM models.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Developer Installation Options
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.

To see what parameters you can use, execute the following from the command line:

install-file /help

where install-file for the following products is as follows:

Enterprise Developer ede_232.exe

See the Examples section further in this topic for examples of some of the parameters you can use.
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Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.

• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFilename

Installing silently

Use the /q parameter to install silently:

start /wait install-file.exe /q [parameters]

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait ede_232.exe /q InstallFolder=c:\DirectoryName

• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait ede_232.exe /q InstallFolder2=c:\EclipseInstallDirectory

• To skip installing JRE when installing Enterprise Developer:

start /wait ede_232.exe /q skipjre=1

• To silently install Rumba during the silent install of Enterprise Developer:

start /wait ede_232.exe /q RumbaCheckbox=1

On UNIX

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it. There are two options for installing the latest version in this
case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/
EnterpriseDeveloper, by default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/EnterpriseDeveloper /opt/microfocus/
EnterpriseDeveloperversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Micro Focus Enterprise Developer UNIX Components installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/EnterpriseDeveloper/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer UNIX Components Installation
Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_2.3_update2_platform -installlocation="full path of new 
location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
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You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Open Perspective >

Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

On Windows

Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product.

To install ViewNowX:

1. Using Windows Explorer, navigate to the folder that contains the ViewNowX executable. By default, this
is %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\ViewNowX.

2. Execute ViewNow_X_Server.exe and then vnx_HF_11327.msp in that folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing on Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
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Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer and Micro
Focus License Administration. Uninstalling only Enterprise Developer does not automatically uninstall
the Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.
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Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:

$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.3.sh script in the $COBDIR/bin
directory.
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Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

•
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• Your entitlement for using this product is governed by the Micro Focus End User License

Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To start Micro Focus License Administration

Windows

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
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4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Finish to install the license.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
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8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Updates and SupportLine | 65

http://www.microfocus.com


Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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